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This guide explains how to customize and deploy SMART Meeting Pro software. This guide also
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This guide is intended for IT administrators and others experienced with customizing, deploying and
administering Windows® software in a networked environment. To use this guide, you must

e Know IT terminology such as “registry” and “domain controller”

¢ Know how to complete basic administrative tasks in Windows operating systems such as

modifying the registry

o Have administrative privileges and access to servers

¢ Have Internet access

IMPORTANT

¢ You must run the commands documented in this guide in an Administrator Command Prompt
window. To open an Administrator Command Prompt window, right-click the Command
Prompticon, and then select Run as Administrator.

¢ You must follow the manufacturer’s configuration instructions for Microsoft® Lync software if
you choose to enable the SMART Meeting Pro connector for Lync collaboration option.

The following table provides information on the different installation components that are available
with SMART Meeting Pro software and Remote Ink by SMART.

Installation components

Purpose

Typical location

SMART Meeting Pro
software with Bridgit
software integration enabled

Enables remote and local teams
to collaborate in real time using
SMART Meeting Pro software in
conjunction with Bridgit
conferencing software.

Meeting room computer

SMART Meeting Pro
software with SMART
Meeting Pro connector for
Lync enabled and Remote
Ink client.

Enables remote and local teams
to collaborate in real time using

SMART Meeting Pro software in
conjunction Lync 2010 software.

Meeting room computer

Remote Ink client

Enables remote participants who
don’t have SMART Meeting Pro
software installed on their
computer to collaborate with other
meeting participants who use
SMART Meeting Pro software
with SMART Meeting Pro
connector for Lync enabled.

Remote meeting participant’s
laptop or desktop computer




CHAPTER 1

Getting started
Installation components  Purpose Typical location
Remote Ink service Enables the room computer of the Computer with a network
meeting participant who's sharing connection to computers hosting
his or her desktop to receive Remote Ink client software
digital ink data from Remote Ink
clients.
i NoTE

You can also deploy SMART Meeting Pro software without enabling a collaboration option (see
Customizing the SMART Meeting Pro installation package on page 18).

To install SMART Meeting Pro software with Bridgit software integration enabled

1.

Ensure your computers meet the minimum software and hardware requirements (see
Computer requirements on page 6).

Download the SMART Product Drivers and SMART Meeting Pro software installation
packages. For more information on the required installation packages (including third-party
installation packages), see Installation packages and supporting files on page 7.

Customize the SMART Meeting Pro software installation packages, including selecting Bridgit
software integration option (see Using SMART Install Manager on page 16 and Using
third-party tools on page 23).

Deploy the installation packages (see Deploying the software on page 25).

Configure SMART Meeting Pro software after deployment if required (see Configuring
SMART Meeting Pro software on page 35).
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To install SMART Meeting Pro software with SMART Meeting Pro connector for Lync
enabled and Remote Ink client

IMPORTANT

You must deploy and configure Lync client software on the computer that will host
SMART Meeting Pro software with the SMART Meeting Pro connector for Lync enabled before you
deploy SMART Meeting Pro software.

The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync Web App)
with a connection to a Lync Server 2010 application.

1. Ensure your computers meet the minimum software and hardware requirements (see
Computer requirements on page 8).

2. Download the SMART Product Drivers and SMART Meeting Pro software installation
packages. For more information on the required installation packages (including third-party
installation packages), see Installation packages and supporting files on page 9.

3. Customize the installation packages, including selecting the SMART Meeting Pro connector
for Lync collaboration option (see Using SMART Install Manager on page 16 and Using
third-party tools on page 23).

4. Download Remote Ink client installation packages. For more information on the required
installation packages (including third-party installation packages), see Installation packages
and supporting files on page 9.

5. Deploy the installation packages (see Deploying the software on page 25).

6. Configure SMART Meeting Pro software after deployment if required (see Configuring
SMART Meeting Pro software on page 35).

7. Configure Remote Ink client (see Configuring Remote Ink software on page 41).
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To install Remote Ink client

IMPORTANT

You must deploy and configure Lync client software on the computer that will host Remote Ink
client, before you deploy Remote Ink client.

The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync Web App)
with a connection to a Lync Server 2010 application.
1. Ensure your computers meet the minimum software and hardware requirements (see

Computer requirements on page 10).

2. Download the Remote Ink client installation packages. For more information on the required
installation packages (including third-party installation packages), see Installation package and
supporting file on page 11.

3. Deploy the installation packages (see Deploying the software on page 25).

4. Configure Remote Ink client (see Configuring Remote Ink software on page 41).

To install Remote Ink service

1. Ensure your computers meet the minimum software and hardware requirements (see
Computer requirements on page 12).

2. Download and deploy the Remote Ink service installation packages. For more information on
the required installation packages (including third-party installation packages), see Installation
package and supporting file on page 12.

3. Deploy the Remote Ink service installation packages (see Deploying the software on page 25).

4. Configure and start Remote Ink service (see Configuring Remote Ink software on page 41).

IMPORTANT

Configure Remote Ink service before you start the service.
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Before you install SMART Meeting Pro software with Bridgit integration enabled, ensure your
computers meet the minimum requirements defined in this section. This section also provides
information on the installation packages and supporting files required for this installation option.

Computer requirements

For all systems
o 1 GB of free hard disk space for minimum installation (additional free space required during
installation)

e 1024 x 768 screen resolution (or higher)
¢ 10 Mbps network connection (100 Mbps recommended) supporting TCP/IP
e Microsoft .NET Framework 4 Full (not Client)
o Microsoft Visual Studio® Tools for Office
For one- or two-display systems
e Windows® XP SP3, Windows 7 or Windows 8 operating systems
e 2 GHz dual-core processor or faster (quad-core recommended)

¢ 1GB of RAM for Windows XP or 2 GB of RAM for Windows 7 or Windows 8 (4 GB
recommended)

o Discrete 128 MB VRAM and support for DirectX® 9 technology
For three- to eight-display systems
e Windows XP SP3, Windows 7 or Windows 8 operating systems
e 2 GHz dual-core processor or faster (quad-core recommended)
e 3 GB of RAM for Windows XP or 4 GB of RAM for Windows 7 or Windows 8
o Discrete 128 MB VRAM and support for DirectX 9 technology
For nine- to 16-display systems

e Windows 7 or Windows 8 (64-bit) operating systems (disabling advanced Aero® theme
recommended)

e 3 GHz dual-core processor or faster (quad-core recommended)
o 8GB of RAM or more

o Discrete 256 MB VRAM and support for DirectX 9 technology
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Installation packages and supporting files
The following installation packages (also known as MSI files) and supporting files are required to
install and configure SMART Meeting Pro software with Bridgit integration enabled.

Save the packages in a location on your network that’s accessible to all the computers on which you
plan to install the software.

Third-party installation packages

The following third-party installation packages are contained in the SMART Meeting Pro software .zip
file available from smarttech.com/administratordownloads. The installation packages are located in
folders in the .zip file.

2 Tip

You can also download these third-party installation packages from microsoft.com/downloads.
Installation package File name

Microsoft .NET Framework 4 dotNetFx40_Full_x86_x64.exe

(Standalone Installer)

Microsoft Visual StudioTools for Office vstor40_x86.exe
for 32-bit computers

Microsoft Visual Studio Tools for Office vstor40_x64.exe
for 64-bit computers

H NoTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all required Microsoft .NET
Framework prerequisites and the Microsoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of the Microsoft .NET Framework files from the
Microsoft website. For information on deploying the Microsoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on the MSDN® website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

SMART software installation packages
Download the .zip files containing these installation packages from
smarttech.com/administratordownloads.

Installation package File name
SMART Product Drivers SMART Product Drivers Installer.msi
SMART Meeting Pro software SMART Meeting Pro.msi



http://www.smarttech.com/administratordownloads
http://www.microsoft.com/downloads
http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://www.smarttech.com/administratordownloads

CHAPTER 1
Getting started

Before you install SMART Meeting Pro software with SMART Meeting Pro connector for Lync
collaboration option enabled, ensure your computers meet the minimum requirements defined in this
section. This section also provides information on the installation packages and supporting files
required for this installation option.

Computer requirements

IMPORTANT
SMART Meeting Pro connector for Lync software supports systems that have a maximum of four

displays.

For all systems
o 1 GB of free hard disk space for minimum installation (additional free space required during
installation)

1024 x 768 screen resolution (or higher)

¢ 10 Mbps network connection (100 Mbps recommended) supporting TCP/IP

¢ Discrete 256 MB VRAM and support for DirectX 9 technology

o Microsoft .NET Framework 4 Full (not Client)

o Microsoft Visual Studio Tools for Office

¢ Microsoft Lync 2010 (full client as opposed to Lync 2010 Attendee or Lync Web App)

¢ Remote Ink client software and Lync SDK redistributable installed

¢ Internet Explorer® 6 or later
For one- or two-display systems

e Windows XP SP3, Windows 7 or Windows 8 operating systems

e 2 GHz dual-core processor or faster (quad-core recommended)

o 1 GB of RAM for Windows XP or 2 GB of RAM for Windows 7 (4 GB recommended)
For three- to four-display systems

e Windows XP SP3, Windows 7 or Windows 8 operating systems (disabling Advanced Aero
theme recommended)

e 3 GHz dual-core processor or faster (quad-core recommended)

e 4 GB of RAM or more
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e You must enable SMART Meeting Pro software integration with Microsoft Exchange to use
the scheduled meeting integration feature in SMART Meeting Pro software.

o Users must be authenticated on a trusted domain with access to a computer hosting Remote
Ink service.

Installation packages and supporting files
The following installation packages (also known as MSI files) and supporting files are required to
install and configure SMART Meeting Pro connector for Lync.

Save the packages in a location on your network that’s accessible to all computers on which you plan
to install the software.

Third-party installation packages

The following third-party installation packages are contained in the SMART Meeting Pro software .zip
file available from smarttech.com/administratordownloads. The installation packages are located in
folders in the .zip file.

a Tip

You can also download these third-party installation packages from microsoft.com/downloads.
Installation package File name

Microsoft .NET Framework 4 dotNetFx40_Full_x86_x64.exe

(Standalone Installer)

Microsoft Visual Studio Tools for Office vstor40_x86.exe
for 32-bit computers

Microsoft Visual Studio Tools for Office vstor40_x64.exe
for 64-bit computers

H NoTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all required Microsoft .NET
Framework prerequisites and the Microsoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of the Microsoft .NET Framework files from the
Microsoft website. For information on deploying the Microsoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on the MSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).
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SMART software installation packages
Download the .zip files containing these installation packages from
smarttech.com/administratordownloads.

H NoTE

The Remote Ink.zip file includes the Lync 2010 SDK runtime installation program
(LyncSdkRedist.msi).

Installation package File name

SMART Product Drivers SMART Product Drivers Installer.msi
SMART Meeting Pro software SMART Meeting Pro.msi

Remote Ink client SMART Remote Ink.msi

Before you install Remote Ink client software, ensure your computers meet the minimum
requirements defined in this section. This section also provides information on the installation
packages and supporting files required for this installation option.

Computer requirements

Windows XP SP3 or Windows 7 operating systems (see the Lync 2010 and the Online Meeting

Add-in for Microsoft Lync 2010 System Requirements web page for minimum hardware

requirements)

10 MB of free hard disk space

1024 x 768 screen resolution (or higher)

Microsoft Lync 2010 (full client as opposed to Lync 2010 Attendee or Lync Web App)
Remote Ink client software and Lync SDK redistributable installed

Microsoft .NET Framework 4 Full (not Client)

VPN access to Remote Ink service or connection through a secure WAN if connecting to
Remote Ink service from outside of a corporate network

H NoTE

Users must be authenticated on a trusted domain with access to the computer hosting Remote Ink

service.
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Installation package and supporting file
The following installation package (also known as an MSI file) and supporting file are required to
install and configure Remote Ink client software.

Save the package in a location on your network that’s accessible to the computer on which you plan
to install the software.

Third-party installation package
The following third-party installation package is contained in the Remote Ink .zip file available from
smarttech.com/administratordownloads. The installation package is located in a folder in the .zip file.

a Tip

You can also download this third-party installation package from microsoft.com/downloads.
Installation package File name

Microsoft .NET Framework 4 dotNetFx40_Full_x86_x64.exe

(Standalone Installer)

H nNoTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all required Microsoft .NET
Framework prerequisites and the Microsoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of the Microsoft .NET Framework files from the
Microsoft website. For information on deploying the Microsoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on the MSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

SMART software installation package
Download the .zip file containing this installation package from
smarttech.com/administratordownloads.

H NnoTE

The Remote Ink .zip file includes the Lync 2010 SDK runtime installation program
(LyncSdkRedist.msi).

Installation package File name
Remote Ink client SMART Remote Ink.msi

11
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Before you install Remote Ink service, ensure your computers meet the minimum requirements
defined in this section. This section also provides information on the installation packages and
supporting files required for this installation option.

Computer requirements
IMPORTANT
Remote Ink service software is not configured for use on untrusted networks such as the Internet.

e Windows Server® 2008 R2 SP1 (see the Installing Windows Server 2008 R2 web page for
minimum hardware requirements)

e 2GBof RAM

e 10 GB of free hard disk space

e Microsoft .NET Framework 4 Full (not Client)

e 10 Mbps wired network connection (1 Gbps wired network is recommended)

e Remote Ink service software at a central site on a dedicated physical or virtual server

Installation package and supporting file
The following installation package (also known as an MSI file) and supporting file are required to
install and configure Remote Ink service software.

Save the package in a location on your network that’s accessible to the computer on which you plan
to install the software.

Third-party installation package
The following third-party installation package is contained in the Remote Ink .zip file available from
smarttech.com/administratordownloads. The installation package is located in a folder in the .zip file.

a2 Tip

You can also download this third-party installation package from microsoft.com/downloads.
Installation package File name

Microsoft .NET framework 4 (Standalone dotNetFx40_Full_x86_x64.exe
Installer)

12
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You can run the dotNetFx40_Full_x86_x64.exe file to install all required Microsoft .NET
Framework prerequisites and the Microsoft .NET framework 4 Full files. However, SMART
recommends that you download the latest version of the Microsoft .NET Framework files from the
Microsoft website. For information on deploying the Microsoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on the MSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

SMART software installation package
Download the .zip file containing this installation package from
smarttech.com/administratordownloads.

Installation package File name

Remote Ink service Remote Ink Service.msi

If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
corresponding MST file for the language is in the same folder as the MSI file (see Installation
language files and codes on page 81).

Similarly, if you want users to be able to view and use the software in a language other than English,
you must download and install the appropriate language pack (see Language packs on page 82).

These language packs are located in the Language folder in the Support folder of the .zip file.

IMPORTANT

SMART Meeting Pro software with the Lync collaboration option enabled supports only English
(U.s.).

13
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You can customize installation packages using SMART Install Manager.
OR

You can customize installation packages using third-party tools and Windows Installer properties.

SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishing MST files. You can then deploy the MSI and MST files to
computers using third-party imaging or remote management software.

Installing SMART Install Manager
Download and install SMART Install Manager from the SMART Support website.

To install SMART Install Manager from the website

1. Go to smarttech.com/administratordownloads.

2. Scroll to SMART Meeting Pro software, click Choose a version, and then select SMART
Meeting Pro software > 3.1 for Windows.

15
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3. Click Download SMART Install Manager, and then click Download.

H NoTE

SMART Install Manager version 1.1.36.0 or newer is required if your product key has 25
characters.

4. Save the Install Manager.exe file to your computer.
5. Double-click the Install Manager.exe file.
The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.

Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu under All Programs > SMART Technologies > SMART Install Manager.
With SMART Install Manager, you can do the following:
¢ Open and customize an installation package.
e Save your changes to the installation package as an XML file.
¢ Publish your changes to the installation packages as an MST file.

Opening an installation package
To customize an installation package, drag its MSI file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking o}

H NoTE

All installation packages you’ve previously opened in SMART Install Manager appear in the
Unmodified Packages tab.

16
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

Z SMART Install Manager: SMART Meeting Pro - Untitled
File Help

Welcome

Page links P

Shorteuts

Microsoft Exchange and E-mail Server Sett...
SMART Meeting Pra Collaboration Informat
Additional Configuration

Gallery Location

SMRRT Install Manager

Installation Options

Installation directory:

Default: [ProgramFilesFolder\SMART Technologies|SMART Meeting Pra

MNote: This option is only used during first installation of the product,

SMART Meeting Pro

Product key:
Enter the 22 o 25 digi product key Far your product
&.0. MP-ABCOE-FGHIK-LMNPQ-RSTUY-AAA

SMART Meeting Pro connector for Lync (for Microsoft Lync client integration)
Product key:

Enter the 22 o 25 digi product key Far your product

&.0. MP-ABCOE-FGHIK-LMNPQ-RSTUY-AAA

Activate SMART software during installation

Saving your changes

Page content

After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening the MSI file and then selecting File > Import.

Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as an MST file. To do this, select File > Publish, and then use the dialog box to define a

location for and create the MST file.

O Tip

If you use an older MST file created with an earlier version of the MSI file, it might not work properly.
Use the current MSI file to create your MST file. Publish the MST file in the same location as the

MSI file.

17
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Customizing the SMART Meeting Pro installation package
To customize the SMART Meeting Pro installation package, open the SMART Meeting Pro.msi file
in SMART Install Manager (see Opening an installation package on page 16), and then set the

controls on each page.

Control

Procedure

Notes

Installation Options

Installation directory

Type the path to your preferred folder
for SMART Meeting Pro software.

If you don’t specify a folder, Windows
Installer installs SMART Meeting Pro
software in C:\Program
Files\SMART
Technologies\SMART Meeting
Pro.

SMART Meeting Pro | Type your 22- or 25-character product | When the software deploys, the
key for SMART Meeting Pro product key activates the software.
software.
SMART Meeting Pro | Type your 22- or 25-character product | You can type the product key with or
connector forLync | key for SMART Meeting Pro without hyphens.
connector for Lync in the appropriate | \When you type a volume product key,
product key box to enable the Lync | the software activates when you
collaboration option. deploy it to your network computers.
Activate SMART Select to activate
Meeting Produring | SMART Meeting Pro software
installation automatically during installation
rather than manually after installation.
Shortcuts
Install Desktop Select to create shortcuts to
shortcut SMART Meeting Pro software on the
desktop.
Launch Select to start SMART Meeting Pro
SMART Meeting Pro | software automatically when the user
at Startup logs on.

Microsoft Exchange

and E-mail Server Settings

Enable integration
with Microsoft
Exchange

Select to enable Microsoft Exchange
integration with SMART Meeting Pro
software.

You must add the room resource’s
unique e-mail address after
installation (see Adding a unique
e-mail address to each computer after
installation on page 37).

Users can access their

Microsoft Outlook® meeting details
and e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software.
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Control

Procedure

Notes

Auto start scheduled
meeting at logon

Select to automatically start
scheduled meetings each time a user
starts a new session.

Auto book ad hoc
meeting at logon

Select to automatically book and start
an unscheduled meeting each time a
user starts a new session.

Auto reset room
after meeting end
time

Select to automatically reset the
room 5 minutes after a meeting’s
scheduled end time. Use the
drop-down menu to change the delay
time.

Auto insert agenda
at meeting start

Select to automatically insert meeting
details into the drawing area each
time a scheduled meeting starts.

Enable SMTP e-mail
configuration

Select to configure SMTP e-mail
settings or the computer’'s default e-
mail client.

If you don’t enable Microsoft
Exchange integration settings, you
can still configure SMTP e-mail
settings. Users are unable to access
their Outlook meeting details, but
they can still e-mail Whiteboard files.

Sender e-mail
address

Type the sender e-mail address for
the SMART Meeting Pro software
installation.

Users can e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software. The
software uses this e-mail address in
the Sender field.

If the computer doesn’t have an
e-mail client installed, enter a do not
reply value. This indicates to mail
recipients that they can’t reply to
e-mails they receive.

SMTP server name

Type the name of the SMTP server.

Users can e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software. The
software uses this e-mail server to
send the file.

Use the computer's
default e-mail client
to send e-mail
messages

Select to use the computer’'s default
e-mail client to send e-mail
messages.

The default e-mail client must be
properly configured for e-mail to be
sent.

SMART Meeting Pro Collaboration Information

Disable remote
collaboration

Select to disable remote
collaboration.

19




CHAPTER 2

Customizing installation packages

(for example, bridgit.example.com).

Control Procedure Notes
Enable Lync Select to enable Lync integration for | The computer hosting
integration SMART Meeting Pro software remote | SMART Meeting Pro software must
. have Lync client software installed
collaboration.
and network access to Lync 2010
Server. To use the features of
Remote Ink by SMART, Remote Ink
client and Remote Ink service
software must also be deployed.
For more information see Selecting
an installation component on page 2.
Enable Bridgit Select to enable Bridgit integration for | If no server name is provided, Bridgit
integration SMART Meeting Pro software remote | software integration is disabled.
collaboration.
Bridgit Server Type the name of the Bridgit server The Bridgit server enables the

SMART Meeting Pro software
installation to connect to other
SMART Meeting Pro software
installations. For more information,
see smarttech.com/bridgit.

Access password

Type the access password for the
Bridgit server.

Creation password

Type the creation password for the
Bridgit server.

Automatically share
primary screen

Select to share the main screen each
time a user starts a new session.

Show meeting
password on
collaboration bar

Select to show the meeting password
in text on the Bridgit Collaboration
Bar.

Additional Configuration

Default mode

Select Desktop to enable
SMART Meeting Pro software to
open in Desktop mode.

OR

Select Whiteboard to enable
SMART Meeting Pro software to
open in Whiteboard mode.
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Control

Procedure

Notes

Default file save
format

Select the default file format that
SMART Meeting Pro software uses
to save whiteboard pages. Select
from the following formats:

o .Notebook
o .pdf
o .ppt (-pptx)

Users are still able to select a
different file format when they save
whiteboard pages.

Files saved in .ppt format have
reduced functionality and can’t be
opened again in SMART Meeting Pro
software.

Ink type

Select Calligraphic to use
calligraphic ink, which smoothes your
writing strokes and improves the
readability of your notes.

OR
Select Regular to use regular ink.

Administrator
password

Type a password that users must
enter to modify the

SMART Meeting Pro software
settings.

If you leave this box blank, no
password will be required to change
SMART Meeting Pro software
settings.

Gallery Location

Save Gallery
content added by
userin

Type the path to your preferred folder
for added content. If you don’t specify
a folder, added content is stored in
the following default folder: [Public
Documents FolderNSMART
Technologies\Gallery\Added
Content.

The Added Content folder is a
location on the local computer where
user-created content is stored.

Additional Gallery
Folder

Type the path to your preferred folder
to add gallery folders.

Customizing the SMART Product Drivers installation package

To customize the SMART Product Drivers installation package, open the SMART Product Drivers
Installer.msi file in SMART Install Manager (see Opening an installation package on page 16), and
then set the controls on each page.

Control

Procedure

Notes

Installation Options

Installation directory

Type the path to your preferred

folder for SMART Product Drivers.

If you don’t specify a folder,
Windows Installer installs
SMART Product Drivers in
C:\Program Files\SMART
Technologies\SMART
Product Drivers.
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Control

Procedure

Notes

Language Selection

Select the language packs
you want to install

Select the language packs you want
toinstall.

Some SMART software doesn’t
support all listed languages.

SMART Product Update (SPU) Options

Install SMART Product
Update in Full mode

Select to install
SMART Product Update (SPU) in
Full mode.

In Full mode, users can view
the installed versions of
SMART software as well as
their product keys, and
download and install updates.

Install SMART Product
Update in Dashboard mode

Select to install SPU in Dashboard
mode.

In Dashboard mode, users can
view only the installed versions
of SMART software and their
product keys.

Do not install SMART

Select to not install SPU.

product updates

SMART product updates through
the Windows notification area.

Product Update
Check for updates Type the number of days (1 to 60) This option is available only if
between SPU checks. you install SPU in Full mode.
By default, SPU checks for
product updates every 30 days.
Notify users about SMART | Select to notify users of available This option is available only if

you install SPU in Full mode.

Customer Experience

Enable the Customer
Experience Program on all
devices

Select to automatically enable the
Customer Experience Program for
all users.

Users can disable the
Customer Experience Program
through the Help menu.

Disable the Customer
Experience Program on all
devices

Select to automatically disable the
Customer Experience Program for
all users.

Users can’t enable the
Customer Experience Program
through the Help menu.

Optional Settings

Register
SMART Document Camera
drivers

Select to enable the registration of
SMART Document Camera™
drivers.

Disable the registration of
SMART Document Camera
drivers if they conflict with the
third-party drivers on the
computer.
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Control

Procedure

Notes

Register unsigned drivers

Select to enable the registration of
unsigned third-party drivers.

If you enable the registration of
unsigned third-party drivers, the
installation process could ask
users if they trust the makers of
the drivers during installation.
This can cause issues if you
deploy the installation in Silent
mode. Therefore, it’s best to
disable the registration of
third-party drivers if you deploy
the installation in Silent mode.

functionality with your SMART
interactive display without having to
connect a Tablet PC.

Start SMART Board Tools | Select to start SMART Board®
at logon Tools when the user logs on.
Enable Tablet PC Support | Select to use Tablet PC This property is applicable to

Windows 7 operating system
only. It has no effect on other
operating systems.

Start SMART Ink at logon

Select to start SMART Ink when the

user logs on.
Make SMART Ink Viewer |Select to make SMART Ink Viewer
the default PDF viewer to the default PDF viewer.

You can customize SMART software installation packages by creating MST files using a third-party
tool, such as Orca database editor, and the Windows Installer properties (see Windows Installer
properties and parameters on page 73).
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You can deploy installation packages using the command line interface.
OR

You can deploy installation packages using third-party imaging or remote management software.

H NoTES

o You might need to manually activate SMART Meeting Pro software after you deploy it (see
Activating SMART Meeting Pro software after installation on page 35).

o You might need to orient your interactive whiteboard again after installing
SMART Meeting Pro software on a multiple display system (see Orienting your
SMART Board interactive whiteboards after installation on page 38).

a Tip

You can install Remote Ink client software and Remote Ink service software on individual
computers by downloading executable files and using the installation wizards to install the
software. You can start the installation wizards by downloading the software from
smarttech.com/software.
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The following tables identify which installation packages you must install and the order they must be
installed in for each software installation option.

IMPORTANT

o Lync client software must be installed and configured on the computer that will host
SMART Meeting Pro software with the SMART Meeting Pro connector for Lync enabled,
before you install SMART Meeting Pro software.

The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync
Web App) with a connection to a Lync Server 2010 application.

o If you're deploying SMART software to computers with Windows XP operating system, you
must install Windows installer 4.5, which is available from
support.microsoft.com/kb/942288.

« You must deploy all the installation packages identified for a software installation option.

SMART Meeting Pro software

Information on where to obtain installation packages can be found in the following locations:

o For SMART Meeting Pro software with Bridgit software integration, see Installation packages
and supporting files on page 7.

o For SMART Meeting Pro software with SMART Meeting Pro connector for Lync enabled, see
Installation packages and supporting files on page 9.

Deploy the following installation packages in the order shown.

IMPORTANT

SMART Meeting Pro software must be installed before Remote Ink client software.

Order Installation package Bridgit Lync Installation instructions
1 Microsoft .NET Framework 4 Extended v v See Installing prerequisite
Profile and Client Profile (if not installed) third-party software on
page 29.
2 Microsoft Visual Studio Tools for Office (if v v See Installing prerequisite
not installed) third-party software on
page 29.
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Order Installation package Bridgit Lync Installation instructions

3  SMART Product Drivers v v See Installing SMART
Product Drivers on page
30.

4 Lync 2010 SDK (Lync SDK redistributable) v For information on
deploying the Lync 2010
SDK, refer to Install Lync
2010 SDK on the MSDN
website
(msdn.microsoft.com/en-
us/library/hh378534.aspx).

H NOTE

The Lync 2010 SDK
runtime installation
program
(LyncSdkRedist.msi) is
included in the SMART
Remote Ink .zip file.

5  Meeting Pro.msi v v See Installing
SMART Meeting Pro
software on page 31.

6 Remote Ink.msi v See Installing Remote Ink
client on page 31.

Remote Ink client software
For information on where to obtain installation packages from, see Installation package and
supporting file on page 11.

Deploy the following installation packages in the order shown.

Order Installation package Installation instructions
1 Microsoft .NET 4 Full Profile (if not installed) See Installing prerequisite third-
party software on page 29.
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Order Installation package

Installation instructions

2 Lync 2010 SDK (Lync SDK redistributable)

For information on deploying the
Lync 2010 SDK, refer to the
Install Lync 2010 SDK on the
MSDN website
(http://msdn.microsoft.com/en-
us/library/hh378534.aspx).

H NOTE

The Lync 2010 SDK runtime
installation program
(LyncSdkRedist.msi) is
included in the SMART
Remote Ink .zip file.

3 Remote Ink.msi

See Installing Remote Ink client
on page 31.

Remote Ink service

For information on where to obtain installation packages, see Installation package and supporting file

on page 12.

IMPORTANT

You must configure Remote Ink service before starting the service after deployment (see

Configuring Remote Ink software on page 41).

Deploy the following installation packages in the order shown.

Order Installation package

Installation instructions

1 Microsoft .Net 4 Extended Profile (if not installed)

See Installing prerequisite third-
party software on the next page.

2 Remote Ink service.msi

See Installing Remote Ink
service on page 32.
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Using the command line interface, you can deploy installation packages in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

For information on updating SMART Meeting Pro software, see Updating the software on page 63.

IMPORTANT

o If you want to install language packs, you must do so when you first deploy the software. If
you want to install a language pack after you first deploy the software, you must do so using
the language pack’s individual MSl file.

o Remote Ink service and Remote Ink client MSI files are not customizable.

o Install Remote Ink service software at a central site using a dedicated physical or virtual
system.

o If youinstall Lync client software after installing SMART Meeting Pro software, you must
restart SMART Meeting Pro software to enable SMART Meeting Pro software integration.

Installing prerequisite third-party software
Use the following procedures to install Microsoft .NET Framework 4 Full files and
Microsoft Visual Studio Tools for Office.

i NoTES

o For more information on the Microsoft .NET Framework, refer to the .NET Framework
Deployment Guide for Administrators on the MSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

o Extended Profile and Client Profile installation packages are part of Microsoft .NET
Framework 4 (Standalone Installer) software.

o For more information on deploying Microsoft Visual Studio Tools for Office, refer to the How
to: Install the Visual Studio Tools for Office Runtime Redistributable on the MSDN website
(msdn.microsoft.com/en-us/library/ms178739.aspx).

To install the Microsoft .NET Framework 4 Full files

Run the following command to install the files in Ul mode:

[Path]\dotNetFx40 Full x86 x64.exe /passive /showfinalerror

OR

Run the following command to install the files in silent mode:

29


http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://msdn.microsoft.com/en-us/library/ms178739.aspx
http://msdn.microsoft.com/en-us/library/ms178739.aspx

CHAPTER 3

Deploying the software

[Path]\dotNetFx40 Full x86 x64.exe /g

Where [Path] is the path to the dotNetFx40_Full_x86_x64.exe file.

To install Microsoft Visual Studio Tools for Office for 32-bit computers
Run the following command:
[Path]\vstor40 x86.exe /g

Where [Path] is the path to the vstor40_x86.exe file.

To install Microsoft Visual Studio Tools for Office for 64-bit computers

Run the following command:

[Path]\vstor40 x64.exe /g

Where [Path] is the path to the vstor40_x64.exe file.

Installing SMART Product Drivers

Use the following procedures to install SMART Product Drivers.

H NoOTES

o Language packs are included in the SMART Product Drivers 11 (and later) .zip files (see
SMART Product Drivers installation package on page 77).

o Forknown installation issues, refer to the Windows operating systems section of the
SMART Product Drivers release notes available from smarttech.com/support.

To install SMART Product Drivers

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]\SMART Product Drivers Installer.msi"

TRANSFORMS="[MST file]" [Parameter]
OR

Run the following command if you didn’t create an MST file to customize the installation
package:

msiexec /i " [Path]\SMART Product Drivers Installer.msi"

[Properties] [Parameter]
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Where

o

[Path] is the path to the SMART Product Drivers Installer.msi file and MST file.

o

[MST file] is the name of the MST file.

o

[Properties] is a set of properties you can include to customize the installation (see
SMART Product Drivers installation package on page 77).

o

[Parameter] is the installation parameter (see Parameters on page 80).

Installing SMART Meeting Pro software

Use the following procedure to install SMART Meeting Pro software.

To install SMART Meeting Pro software

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]\SMART Meeting Pro.msi" TRANSFORMS="[MST file]"

[Parameter]

OR

Run the following command if you didn’t create an MST file to customize the installation
package:

msiexec /1 " [Path]J\SMART Meeting Pro.msi" [Properties]

[Parameter]

Where

o

[Path] is the path to the SMART Meeting Pro.msi file and MST file.

o

[MST file] is the name of the MST file.

o

[Properties] is a set of properties you can include to customize the installation (see
SMART Meeting Pro installation package on page 73).

o

[Parameter] is the installation parameter (see Parameters on page 80).

Installing Remote Ink by SMART
Use the following procedures to deploy Remote Ink server software and Remote Ink client software
using the command line interface.

Installing Remote Ink client
Use the following procedure to install Remote Ink client software.
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To install Remote Ink client

Run the following command if there is no previous installation of Remote Ink client on your computer:

msiexec /i " [Path]\Remote Ink Client.msi"

OR

Run the following command if there is a previous installation of Remote Ink client on your computer:

msiexec /i " [Path]\Remote Ink Client.msi" REINSTALL=ALL
RINSTALLMODE=vomus

Where [Path] is the path to the Remote Ink Client.msi file.

For information on configuring Remote Ink client software to discover and connect to Remote Ink
service software, see Configuring Remote Ink software on page 41.

Installing Remote Ink service
Use the following procedure to install Remote Ink service on a server meeting the requirements listed
in Remote Ink service on page 12.

To install Remote Ink service

Run the following command:

msiexec /i " [Path]\Remote Ink Service.msi"

Where [Path] is the path to the Remote Ink Service.msi file.
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The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remote management software, see the software’s documentation.

H NoTE

This procedure may vary depending on your version of Windows operating system and your system

preferences.

To deploy an installation package

1.

10.
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Copy the MSI file and the MST file to \\[Domain ControllerANETLOGON, where
[Domain Controller] is your domain controller.

Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

The Active Directory Users and Computers window appears.
Right-click your domain, and then select Properties.

The Properties dialog box appears.

Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

Browse to Computer Configuration\Software Settings.

Right-click Software Installation, select New > Package, and then browse to and select the
MSI file from step 1.

In the Deploy Software section, click Advanced, and then click OK.

Click the Modifications tab, click Add, and then browse to and select the MST file from
step 1.

Click OK to apply the MST file to the MSl file.
Close all open windows and dialog boxes.

The next time each computer on the domain starts, the computer automatically installs the
software in Silent mode with the customizations defined in the MST file.
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Orienting your SMART Board interactive whiteboards after installation ................................ 38

This chapter provides information on using the following procedures to configure SMART Meeting Pro
software after installation.

o Activating SMART Meeting Pro software after installation
¢ Adding a unique e-mail address to each computer

¢ Orienting your SMART Board interactive whiteboards

There are two situations in which the software doesn’t activate completely:

o Imaging a computer: For the software to activate properly, each computer you install it on
must have a unique installation ID. If you use a computer image or clone a hard drive to set up
multiple computers, they all have the same installation ID as the original computer, which can
cause an activation error.

o Protecting software for computer configurations: If you use system recovery or protection
software, you should activate the software before you lock or freeze the computer for your
users. However, if you can’t, you must activate the software afterward.

IMPORTANT

SMART Meeting Pro software and SMART Meeting Pro connector for Lync have separate product
keys. You must enter both product keys during the software installation process to use
SMART Meeting Pro software with Lync integration enabled.
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To activate SMART Meeting Pro software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\SMART Product
Updatelactivationwizard.exe" --puid meeting pro --m=[Value] --

v=3 --a [Optional flags] --pk [Product key]
Where
o [Value] is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface ina
specific language, where [Code] is your language
code (see Installation language files and codes on
page 81).

o [Product key] is the software product key.
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To activate SMART Meeting Pro connector for Lync software after installation
Run the following command:
"C:\Program Files\Common Files\SMART Technologies\SMART Product

Updatelactivationwizard.exe" --puid meeting pro --m=[Value] --

v=3 --a [Optional flags] --pk [Product key]

Where [Product key] is the SMART Meeting Pro connector for Lync product key.

H NOTES

o You can add multiple product keys by entering multiple instances of the product key
command line property (--pk [Product key]).

o You can also activate SMART Meeting Pro connector for Lync through
SMART Product Update (SPU) by accessing the SMART Meeting Pro software entry
in the product list and adding the SMART Meeting Pro connector for Lync product key.

For proper integration of Microsoft Exchange, each computer you install SMART Meeting Pro
software on must have a unique room resource e-mail added in the registry entry. This e-mail address
identifies the room within your Microsoft Exchange Server. This enables users to reserve a room
resource by booking the room in the same way they book other meeting participants.

Complete the following procedure to add a unique room resource e-mail address to the registry entry
of each computer.

CAUTION

Use caution when you open the Windows registry editor. If you incorrectly modify the Windows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

TP

For information on configuring a mass deployment of unique room resource e-mail addresses, see
the online Help systems for your network administration tools.
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To add an e-mail address to the registry entry after installation
1. Select Start > Run.
The Run dialog box appears.
2. Typeregedit, and then click OK.
The Registry Editor window appears.

3. Use the following table to locate the appropriate key for your operating system.

Operating system Folder location:

Windows XP and HKEY_LOCAL_MACHINE\Software\SMART

Windows 7 (32-bit) Technologies\SMART Meeting Pro\Version 3.1\MSExchange
operating system

Windows 7 (64-bit) HKEY_LOCAL_MACHINE\Software\Wow6432Node\SMART
operating systems Technologies\SMART Meeting Pro\Version 3. 1\MSExchange

4. Right-click MeetingRoomEmail, and then select Modify.

5. Type the room resource computer’'s unique e-mail address in the Value data box, and then click
OK.

6. Close the Registry Editor window.
7. Restart SMART Meeting Pro software.

If after you install SMART Meeting Pro software on a multiple display system your touch on one
screen registers on another, you must orient your interactive product again.

Use the following procedure to orient your interactive product using SMART Settings.

a Tip

You can also access the screen orientation procedure from the Pen Tray. See your interactive
product’s user’s guide for more information.

To orient multiple interactive products

1. Press the SMART Meeting Pro icon E in the notification area, and then select
SMART Settings.

38



CHAPTER 4
Configuring SMART Meeting Pro software

39

If your computer isn’t currently connected to an interactive product, the SMART Meeting Pro
icon is gray and includes an X in its lower-right corner E2.

. Select SMART Hardware Settings.

The upper area of the widow displays an image for each interactive product connected to the
compulter.

. Select the interactive product you want to orient.

Press Orient.

H NoTE

Sometimes, the orientation screen appears on your primary interactive product instead of the
interactive product you want to orient. If this happens press SPACEBAR until the orientation
screen appears on the interactive product you want to orient.

. Touch the center of each target in the order indicated. The computer registers the point on the

interactive product where you remove your finger or pen tool from the surface.

The orientation procedure involves pressing 4, 9, 12 or 20 targets, depending on the orientation
level you select (see the SMART Meeting Pro software online Help for more information on
changing the orientation level of your interactive product).
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This chapter provides information on configuring Remote Ink service and Remote Ink client after
deployment.

The following table identifies the required, recommended and optional Remote Ink software
configuration procedures.

Configuration procedure Required Recommended Optional

Configuring a base address and domain name system v
(DNS) value for Remote Ink service (see Configuring base

address and DNS values for Remote Ink service on page

43)

IMPORTANT

You must configure a base address and DNS value for
Remote Ink service before you start the service.

Configuring Remote Ink client to autodiscover Remote Ink v
service using an SRV DNS resource record (see

Configuring autodiscovery of Remote Ink service on page

44)

Enabling Remote Ink client to connect to Remote Ink v
service with user-specified and cached service information

(see Configuring user-specified and cached service

information on page 48)
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Configuration procedure Required Recommended Optional

Configuring how significant Remote Ink service program v
events are logged (see Configuring event logs on page 50)

Configuring meeting cleanup in Remote Ink service (see v
Configuring meeting cleanup on page 52)

Starting Remote Ink service after installation (see Starting v
Remote Ink service on page 53)

Remote Ink service is a Windows Communication Foundation (WCF) service that enables meeting
participants using SMART Meeting Pro software with SMART Meeting Pro connector for Lync
enabled to write and draw on shared desktop content. Remote Ink service runs as a self-hosted
Windows service.

H NOTES

« Remote Ink service requires the use of a duplex binding (NETTCP) to enable bidirectional
communication. For more information, see msdn.microsoft.com/en-
us/library/ms731343.aspx.

o By default, Remote Ink service uses a secure binding configuration that provides transport
encryption (TLS) using Windows Credentials. Remote Ink service can also be configured to
use a certificate.

o For more information about the WCF framework, see msdn.microsoft.com/en-
us/netframework/aa663324.aspx.
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Use the following procedure to configure a base address and DNS value for Remote Ink service.

To configure the base address and DNS value
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1. Goto C:\Program Files\SMART Technologies\Remote Ink Service.
2. Open Remoteinkservice.exe.config with a text editor.

3. Scroll to and change the base address to the following:

<add baseAddress="net.tcp://
[myhost.example.com]:35706/RemoteInk" />

Where

o [myhost.example.com] is the fully qualified domain name (FQDN) of the computer
hosting Remote Ink service software.

o The port number 35706 is configurable.

<add baseAddress="net.tcp://1.2.3.4:35706/RemoteInk" />
4. Scroll to and change the dns value to the following:

<dns value="[Domain name]"/>

Where [Domain name] is the domain name of the computer hosting Remote Ink service.

<dns value="example.inc"/>

5. Savethefile.
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This section provides information on recommended procedures for configuring how Remote Ink client
connects to Remote Ink service.

IMPORTANT

If you do not complete the procedures in this section, users are prompted to enter the Remote Ink
service IP/Domain name each time they first log on to a computer hosting Remote Ink client
software (for example, the first time they use SMART Meeting Pro software with SMART Meeting
Pro connector for Lync enabled in a meeting room or as a remote participant using Remote Ink
client).

The following procedures are given in this section:
o Configuring Remote Ink client software to autodiscover Remote Ink service
¢ Checking whether a computer can see an SRV record

¢ Configuring user-specified and cached service information

Configuring autodiscovery of Remote Ink service
This section explains how to configure Remote Ink client to autodiscover Remote Ink service using
an SRV DNS resource record.

You can enable Remote Ink client software to autodiscover Remote Ink service by creating the
appropriate SRV record on the network hosting Remote Ink service. Following installation, Remote
Ink client will attempt to discover Remote Ink service by looking up an SRV DNS resource record
that points to the Remote Ink service.

IMPORTANT

o If an SRV record pointing to the Remote Ink service has not been created on the network
hosting Remote Ink service and roaming user profiles are not configured, then users are
prompted to enter the Remote Ink service IP/Domain name when they first log on to a
computer hosting Remote Ink client (for example, the first time they use Remote Ink client
software in that meeting room).

o If roaming user profiles are configured users are prompted only once to enter the Remote Ink
service IP/Domain name when they first log on to a computer hosting Remote Ink client and
are not prompted again.
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To enable DNS autodiscovery, you must add the SRV record to any domain from which a user can
connect to a hosting of Lync server software.

If a user logs on to a hosting of Lync server software with a user ID such as user1@example.com,
then the SRV record must be installed in the example.com domain. If another user can also log on
to the same Lync server software with a different user ID such as user2@anotherdomain.com,
then to enable this user to autodiscover the Remote Ink service, the SRV record must also be
added to the anotherdomain.com domain (or the user is prompted for the server information).

If all Lync server software users have |IDs that each feature the same domain name, then the SRV
record need be installed only in the domain that the users share.

The following procedures can be used to create an SRV record:

o Manually configure the SRV record using the DNS server's management interface

OR

o Use a Microsoft PowerShell® script provided under the Remote Ink service installation in the

Tools folder.

To manually configure the SRV record using the DNS server’s management interface

Create a record with the following values:

o

[¢]
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Name: _smartremoteink
Protocol: _tcp

Priority: O

Weight: 0

Port: 35706

H NoTE

This port number is configurable and must match the number of the port chosen for
Remote Ink service.

Host: Name of the computer hosting Remote Ink service, for example, ink.example.local
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To use a PowerShell script provided under the software installation in the Tools folder

Run the following command to add an SRV record from using the command line interface:

powershell.exe -noexit <full path to>\ManageSrvRecord.psl -
install -nameserver <host name of name server> -zone <zone> -

target <host machine name> -ttl <time-to-live> -port 35706
Where

o [full path to] is the location of the Tools folder in the Remote Ink service installation.

C:\Program Files\SMART Technologies\Remote Ink Service\Tools

o [host name of name server] is the name of the DNS name server (i.e. the domain
controller).

o [zone] is the DNS zone in which the SRV record should be installed.
o [host machine name] is the name of the computer hosting Remote Ink service.

o [time-to-live] is the number of seconds a computer hosting Remote Ink client is
recommended to cache the DNS record in its local DNS cache.

H NoTE

Use a value of 0 to avoid caching the DNS record. The default value for this parameter,
if not specified, is 86400 (i.e. 24 hours).

powershell.exe -noexit “C:\Program Files\SMART
Technologies\Remote Ink Service\Tools”\ManageSrvRecord.psl -
install -nameserver dcl -zone example.local -target

ink.example.local -ttl 86400 -port 35706
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H NoTE

By default, the ManageSrvRecord.ps1 uses a time to live (TTL) value of 86400 (24 hours). This
means that any DNS service that queries this SRV record caches the record for 24 hours. This
includes the DNS component that runs on every desktop computer. If you're planning to move
Remote Ink service to a different computer and are using a non-zero TTL for the SRV record, the
SRV record must be removed 48 hours before Remote Ink service is moved. The SRV record must
then be replaced by a record with a 0 TTL value as part of the command used to add an SRV record.
This procedure gives each Remote Ink client application time to clearits DNS cache. Alternatively,
if youuse a TTL of 0 you don’'t have to complete these actions.

If anew O TTL value isn’'t used for the SRV record, computers hosting Remote Ink client that still
have the old invalid SRV record in cache don’t see the computer hosting Remote Ink service in its
new location (see Checking whether a computer can see an SRV record below for information on
determining which SRV record a computer sees). A computer's DNS cache can be cleared
manually using the ipconfig /flushdns command.

Checking whether a computer can see an SRV record
To check whether a computer can see an SRV record, use the nslookup command:
C:\> nslookup -type=SRV smartremoteink. tcp.example.local
Optionally, on the computer where Remote Ink service is installed, use the following command:

powershell.exe -noexit “C:\Program Files\SMART Technologies\Remote Ink
Service\Tools”\ManageSrvRecord.psl —-query —-nameserver dcl -zone

example.local

Whenever Remote Ink client connects to Remote Ink service, an entry is made in the Remote Ink
software event log on the computer hosting Remote Ink client. This connection information could be
useful in troubleshooting issues.

For example, the following log entry shows that Remote Ink client discovered the Remote Ink service
by looking up its DNS SRV record:

Discovered service net.tcp://ink.example.local:35706/RemoteInk via SRV
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The following entry example shows that Remote Ink client previously connected to Remote Ink
service and cached the Remote Ink service information. Remote Ink service then used the cached
information to connect this time:

Discovered service net.tcp://ink.example.local:35706/RemotelInk in

Cache

Configuring user-specified and cached service information

If you are unable to use autodiscovery using DNS SRV records (for example, the DNS server cannot
be configured as described in Configuring autodiscovery of Remote Ink service on page 44), then the
Remote Ink client software will prompt you for the host name and port number of the computer
hosting Remote Ink service. You won’t be prompted to enter the host name and port number again
unless this information changes (for example Remote Ink service is moved to a different computer).

IMPORTANT
The port number must consist of numeric characters only. Do not type in separator characters,

such as spaces, commas or periods.

Use the following procedures to add the IP/Domain name and port number of the computer hosting
Remote Ink service to Remote Ink client software’s Remotelnk.exe.config file. Adding these details
to the config file enables Remote Ink client software to connect to Remote Ink service without trying
to find the SRV record pointing to the Remote Ink service on the network.

Use the following procedure to configure the Remotelnk.exe.config file ina SMART Meeting Pro
software installation or a Remote Ink client installation.

To configure the Remotelnk.exe.config file in a installation

1. Go to the folder location appropriate to your operating system:

Operating Location:

system

32-bit C:\Program Files\SMART Technologies\SMART Meeting
Pro\Remote Ink

64-bit C:\Program Files (x86)\SMART Technologies\SMART Meeting

Pro\Remote Ink

2. Copy the Remotelnk.exe.config file.
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3. Modify the contents of the copied Remotelnk.exe.config file as follows:

o Change the value of the AutoDiscoverServiceEnabled key from true to false.

a Tip

Changing the AutoDiscoverServiceEnabled key to false prevents Remote Ink client
from looking for an SRV record.

o Uncomment the Servicelnfo key, and replace example.com:12345 with the name of

the computer hosting Remote Ink service and its port number.

adTip

The default port number of the computer hosting Remote Ink service is 35706.
4. Replace the existing Remotelnk.exe.config file with the modified Remotelnk.exe.config file.

5. Goto %APPDATA%\SMART Technologies\Remotelnk\RemotelnkClientSettings.xml,
and then delete RemotelnkClientSettings.xml (if it exists).

To configure the Remotelnk.exe.config file when only the is installed

1. Go to the folder location appropriate to your operating system:

Operating Location:

system

32-bit C:\Program Files\SMART Technologies\Remote Ink
64-bit C:\Program Files (x86)\SMART Technologies\Remote Ink

2. Copy the Remotelnk.exe.config file.
3. Modify the contents of the copied Remotelnk.exe.config file as follows:

o Change the value of the AutoDiscoverServiceEnabled key from true to false.

O Tip

Changing the AutoDiscoverServiceEnabled key to false prevents Remote Ink client
from looking for an SRV record.

o Uncomment the Servicelnfo key, and replace example.com:12345 with the name of

the computer hosting Remote Ink service and its port number.

B 1niep

The default port number of the computer hosting Remote Ink service is 35706.

4. Replace the existing Remotelnk.exe.config file with the modified Remotelnk.exe.config file.
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5. Goto %APPDATA%\SMART Technologies\Remotelnk\RemotelnkClientSettings.xml,
and then delete RemotelnkClientSettings.xml (if it exists).

IMPORTANT

o If the network address of the computer hosting Remote Ink service software changes, then
you have to reconfigure the Remotelnk.exe.config file with the new address for the
computer hosting Remote Ink service.

¢ |f you migrate Remote Ink service to a new host computer, you must uninstall the software
from its original host computer. This is because computers hosting Remote Ink client have
cached the network address of the original computer hosting Remote Ink service and will
continue to attempt to connect to this computer. However, some computers hosting Remote
Ink client will attempt to autodiscover and connect to the new computer hosting Remote Ink
service. Computers hosting Remote Ink client that are connected to different Remote Ink
service host computers are unable to interact with each other using Remote Ink service.

This section provides information on the following optional Remote Ink service configuration
procedures.

e Configuring event logging

o Configuring meeting cleanup

Configuring event logs
This section contains information on configuring the way significant Remote Ink service program
events are logged. Use the procedures in this section to do the following:

e Configure which significant Remote Ink service program events are logged.

o Create a custom event source to redirect output from the default application log to a log
dedicated to Remote Ink service program events.

2 Tip

Redirecting output from the default application log is helpful if you're troubleshooting Remote
Ink service and want a log containing only Remote Ink service program events.
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To configure which program events are logged
1. Goto C:\Program Files\SMART Technologies\Remote Ink Service.
2. Open Remoteinkservice.exe.config with a text editor.

3. Scroll to and change the comment for the following command:

<add key="LogLevel" value="[value]" />
Where [value] determines which events are logged.

Choose the events you want to log by entering a value from the table below.

Value Eventlevel This value enables you to log the following event information:

0 Error Error

1 Warning Warmning and Error

2 Informational Informational, Warning and Error

3 Debug Debug, Informational, Warning and Error

To create a custom event source

1. Create a PowerShell script that contains the following commands and modify the
customeventsource and logname variables to your custom values.

TIP

You can also execute the following commands directly in a PowerShell console.

Scustomeventsource = [My Custom Source]
Slogname = [Application]

ScreationData = new-object

System.Diagnostics.EventSourceCreationData $customeventsource,

$logname
[System.Diagnostics.EventLog]::CreateEventSource (ScreationData)
Where:
o [My Custom Source] is the new name of the customeventsource variable

o [Application] defines which event log is associated with the EventSource variable

2. Executein a PowerShell console.
3. Goto C:\Program Files\sSMART Technologies\Remote Ink Service.

4. Open Remoteinkservice.exe.config with a text editor.
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5. Change the default EventSource name to the name you gave to the customeventsource
variable, for example My Custom Source.

Configuring meeting cleanup

You can configure Remote Ink service to use one of two methods to clean up meetings that have
expired and were not exited properly. When a collection is run, the service compares each meeting’s
last activity time with the configured user session timeout. If there has been no activity for a greater
amount of time than the session timeout, then the meeting is removed.

H NoTES

« Remote Ink client includes a keep-alive function, so program information from meetings that
are in progress is never removed.

o By default the service is configured to use the scheduled time of 04:00 to clean up meetings.

o If ascheduled collection interval is enabled this setting takes priority over using a scheduled
collection time. For example, if the service configuration has both the scheduled collection
time and an interval defined, the service uses the scheduled collection interval.

Use the following procedure to configure Remote Ink service to capture program events at a set
interval.

To capture program events at a set interval
1. Goto C:\Program Files\SMART Technologies\Remote Ink Service.
2. Open Remoteinkservice.exe.config with a text editor.
3. Scroll to and remove the comments from the following command:
<add key="ScheduledCollectionInterval" value="01:00"/>
Where [1:00] is the interval that collection is run.

H NoTE

Removing the comments from this command enables Remote Ink service to clean up
meetings at a set interval rather than at a scheduled time each day.
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Use the following procedure to start Remote Ink service.

To start Remote Ink service
1. Goto C:\Windows\system32.
2. Double<lick services.msc.
The Services dialog box appears.
3. Scroll to Remote Ink Service, and then click the service.
4. On the action menu, click Start.

Remote Ink service starts.

K Tips
o If Remote Ink service doesn't start, ensure the following:

o Microsoft.NET 4 Full (not Client) is installed on the computer hosting Remote Ink

service.

o A firewall configuration isn’t blocking network traffic to and from the Remote Ink

service.

o If youdon't see any log messages, check that the event source has been created.
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This chapter provides information on configuring the Microsoft Exchange settings for
SMART Meeting Pro software using the SMART Meeting Pro Settings dialog box.
Information is provided on the following configuration options:

o Accessing administrator settings

o Configuring settings

o Checking registry values assigned during the configuration process

o Configuring e-mail settings

H NoTE

The SMART Meeting Pro Settings dialog box is available on each computer that hosts
SMART Meeting Pro software when the software is running.

You can change various administrator settings, including your administrator password.

To access the SMART Meeting Pro Settings dialog box

1. Press the SMART Meeting Pro E icon in the notification area, and then select
SMART Settings.
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2. Press SMART Meeting Pro Settings.
The SMART Meeting Pro Settings log on dialog box appears.

3. Type your administrator password, and then press OK.

i NoTE
There is no password by default.

The SMART Meeting Pro Settings dialog box appears.

To change the administrator password

1. Press the SMART Meeting Pro E icon in the notification area, and then select
SMART Settings.

2. Press SMART Meeting Pro Settings.
The SMART Meeting Pro Settings log on dialog box appears.
3. Press Change Password.
The Change administrator password dialog box appears.
4. Type your current password and new password in the appropriate boxes.

5. Press OK.

You can change various administrator settings that include enabling Microsoft Exchange integration,
changing automatic settings and configuring a service account.

IMPORTANT

You must restart SMART Meeting Pro software to apply changes to the configuration settings
described in this section.

i NoTES

o To check whether Microsoft Exchange is enabled, switch to Organizer mode. If a Meeting
tab appears, Microsoft Exchange is enabled.

o Forinformation on creating a room account in Microsoft Exchange 2007 or Microsoft
Exchange 2010, consult the Microsoft website.

Use the following procedures to complete a basic configuration of Microsoft Exchange integration
with SMART Meeting Pro software.
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To enable Microsoft Exchange integration

—_

o > w0 DN

Access the SMART Meeting Pro Settings dialog box.

Press the Microsoft Exchange tab.

Select Enable Microsoft Exchange integration.

Type your meeting room resource e-mail address in the appropriate box.

Press OK.

To enable automatic starting of scheduled meetings

—_

Access the SMART Meeting Pro Settings dialog box.
Press the Microsoft Exchange tab.
Select Auto start scheduled meeting at logon.

Press OK.

To enable automatic ad hoc meeting creation

1.

2
3.
4

Access the SMART Meeting Pro Settings dialog box.
Press the Microsoft Exchange tab.
Select Auto book ad hoc meeting at logon.

Press OK.

To enable the automatic end meeting feature

—_

Access the SMART Meeting Pro Settings dialog box.
Press the Microsoft Exchange tab.
Select Auto reset room after meeting end time.

Press OK.

To change the delay time before your meeting automatically ends

57

1.

2
3
4.
5

Access the SMART Meeting Pro Settings dialog box.

Press the Microsoft Exchange tab.

. Select Auto reset room after meeting end time.

Select 1, 5 or 10 minutes from the drop-down menu.

Press OK.
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To enable automatically inserting your meeting details

—_

Access the SMART Meeting Pro Settings dialog box.
2. Press the Microsoft Exchange tab.

3. Select Auto insert agenda at meeting start.

4

Press OK.

You can also use the SMART Meeting Pro Settings dialog box to configure the following advanced
settings:

IMPORTANT
You must restart SMART Meeting Pro software to apply changes to the configuration settings
described in this section.

o Configure SMART Meeting Pro software to use a service account instead of using the

logged-on user’s credentials.

o Manually specify the URL of the Microsoft Exchange and Active Directory® servers that
SMART Meeting Pro software authenticates against.

[ Il

By default SMART Meeting Pro software detects your local Microsoft Exchange and Active
Directory servers.

To configure a service account

1. Access the SMART Meeting Pro Settings dialog box.

2. Press the Microsoft Exchange tab.
3. Select Use service account instead of logged on user’s credentials.
4. Type your domain, user name and password in the appropriate boxes.
5

Press OK.

To configure server settings
1. Access the SMART Meeting Pro Settings dialog box.

2. Press the Microsoft Exchange tab.
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3. Press Server Settings.
The Microsoft Exchange Server and Active Directory Server settings dialog box appears.

4. Press OK.

When you use the SMART Meeting Pro Settings dialog box to configure Microsoft Exchange, the
following registry keys are automatically configured:

e Meeting room e-mail
¢ Service account credentials
¢ Microsoft Exchange Server and Active Directory

Use the following procedure to ensure that the correct registry values were assigned during the
Microsoft Exchange configuration process.

CAUTION

Use caution when you open the Windows registry editor. If you incorrectly modify the Windows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

To check the registry key values
1. Log on to the computer hosting SMART Meeting Pro software as an administrator.
2. Select Start > Run.
The Run dialog box appears.
3. Type regedit and then click OK.
The Registry Editor window appears.
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4. Use the following table to locate the appropriate key for your operating system.

Operating system Folder location:

Windows XP and HKEY_LOCAL_MACHINE\Software\SMART

Windows 7 (32-bit) Technologies\SMART Meeting Pro\Version 3.1\MSExchange
operating system

Windows 7 (64-bit) HKEY_LOCAL_MACHINE\Software\Wow6432Node\SMART
operating systems Technologies\SMART Meeting Pro\Version 3.1\MSExchange

5. Check the following registry key:

Name Description

MeetingRoomEmail SMART Meeting Pro software uses this registry key for the room
e-mail address. This key is required and should contain the e-
mail address of the meeting room in which SMART Meeting Pro
software is installed.

AuthUsername and If you selected the Use service account instead of logged-on

AuthPassword user’s credentials option in the Microsoft Exchange tab, then
registry keys exist for the service account logon name and
password.

AuthADServer and If you didn’t select automatic detection of Microsoft Exchange

ConnURL Server and Active Directory server options during Microsoft

Exchange configuration, then SMART Meeting Pro software will
require Active Directory and Microsoft Exchange server
addresses.

If you don’t enable integration with Microsoft Exchange, you can configure SMTP e-mail settings or
the computer’s default e-mail client. You can also restore the e-mail settings to default.

H NOTES

o Youdon't need to configure these e-mail settings if you enabled Microsoft Exchange
integration.

o If you don’t enable Microsoft Exchange integration, you’re unable to use the Meeting
Notification features of SMART Meeting Pro software. However, you can use SMTP e-mail
configuration to send your meeting notes from Whiteboard mode.

To configure SMTP e-mail settings

1. Press the SMART Meeting Pro E icon in the notification area and then select
SMART Settings.
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2. Press SMART Meeting Pro Settings.

The SMART Meeting Pro Settings log on dialog box appears.
Type your administrator password, and then press OK.
Press the E-mail tab.

Type the sender e-mail address in the appropriate box.

H NoTE

The e-mail address you enter will appear in the Sender field for any outgoing e-mails. If the
computer doesn’t have an e-mail client installed, don’t change the do not reply default value.
This indicates to mail recipients that they can’t reply to e-mails they receive.

Type your SMTP server location in the appropriate box.
Press OK.

The SMTP e-mail settings are detected, enabling you to use the e-mail features of
SMART Meeting Pro software.

To configure the computer’s default e-mail client

1.

2
3.
4

Access the SMART Meeting Pro Settings dialog box.
Press the E-mail tab.
Select Use system e-mail.

Press OK.

H NoTE

The computer's default e-mail address will appear in the Sender field for any outgoing
e-mails.

To restore default settings
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Access the SMART Meeting Pro Settings dialog box.
Press the E-mail tab.
Select Restore Defaults.

Press OK.
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SMART periodically releases updates to its software. These updates add new features and resolve
issues.

Go to smarttech.com/software to download the latest installation package. SMART provides updates

in MSI file format in the installation package:

o Windows Installer update installation packages (MSI files)

After you download an installation package and extract the update files, place the update files in a
location on your network that’s accessible to all the computers you plan to update.

IMPORTANT

You cannot roll back an update after installing it on your computers. You must remove the full
version of the software using Control Panel or the command line interface (see Removing the
software on page 65), and then install the previous version of the software.

The command line for running an update using a Windows Installer update installation package varies
depending on whether the update is major or minor.

H NoTE

The SMART website indicates whether an update is major or minor.
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To run a major software update using a Windows Installer update installation package

Run the following command:

msiexec /i " [Path]\ [File].msi" [Parameter]
Where
o [Path] is the path to the MSI file.
o [File] is the name of the MSI file.

o [Parameter] is the installation parameter (see Parameters on page 80).

To run a minor software update using a Windows Installer update installation package

Run the following command:

msiexec /i " [Path]\ [File].msi" REINSTALL=ALL REINSTALLMODE=vomus

[Parameter]

Where
o [Path] is the path to the MSI file.
o [File] is the name of the MSI file.

o [Parameter] is the installation parameter (see Parameters on page 80).
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Using the command line interface ... . 65
Using third-party imaging or remote management software ... ... ... 70

You can remove SMART software using the command line interface.
OR

You can remove SMART software using third-party imaging or remote management software.

Using the command line interface, you can remove SMART software in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

IMPORTANT

Remove the common platform only after you remove all other SMART software.

To remove SMART Meeting Pro software
Run the following command:
msiexec /x " [Path]\SMART Meeting Pro.msi" [Parameter]

Where

o [Path] is the path to the SMART Meeting Pro.msi file.

o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove the software using the product code:

msiexec /x [Product code] [Parameter]
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Where

o [Product code] is the product code for the version of SMART Meeting Pro software
you're removing, including the braces (“{" and “}").

Version Product code

2.0 {696BD3B5-DC48-4AD2-A60A-4C39C9852294}
2.1 {4BD7F008-CDD9-454D-8A5B-4FF8BB8FEF02}
2.2 {76F84A17-835E-46C7-9C31-520BAFD5AC9D}
2.3 {E1660294-4C1E-4893-A40D-FFE0051E824F}
3.0 {C75C357C-3368-4142-AC8D-9F528B57373D}
3.1 {OF31DCED-1093-44C8-B606-70C5F108E70B}
3.1 SP1 {A6C3D76B-3CDB-4A35-82B3-E66B9B518152}

o [Parameter] is the installation parameter (see Parameters on page 80).

To remove Remote Ink service software

Run the following command:

msiexec /x " [Path]\Remote Ink Service.msi" [Parameter]
Where
o [Path] is the path to the Remote Ink Service.msi file.
o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove the software using the product code:

msiexec /x [Product code] [Parameter]

Where

o [Product code] is the product code for the version of Remote Ink service software you're
removing, including the braces (“{" and “}").

Version Product code

1.0 {7B388E17-638C-4DCF-986E-F68D 33974130}

o [Parameter] is the installation parameter (see Parameters on page 80).
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To remove Remote Ink client software

Run the following command:

msiexec /x " [Path]\Remote Ink Client.msi" [Parameter]
Where
o [Path] is the path to the Remote Ink Client.msi file.
o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove the software using the product code:

msiexec /x [Product code] [Parameter]

Where

o [Product code] is the product code for the version of the Remote Ink client you're
removing, including the braces (“{" and “}").

Version Product code
1.0 {B6FCC721-9A73-46EA-88C6-7FC2F5138F24}

o [Parameter] is the installation parameter (see Parameters on page 80).

To remove SMART Product Drivers

IMPORTANT
Removing SMART Product Drivers prevents other SMART software products from running.

If you installed SMART Product Drivers using the SMART Product Drivers Installer.msi file,
run the following command to remove the software using the installation package:

msiexec /x " [Path]\SMART Product Drivers Installer.msi"

[Parameter]
Where

o [Path] is the path to the SMART Product Drivers Installer.msi file.

o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove the software using the product code:

msiexec /x [Product code] [Parameter]
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Where

o [Product code] is the product code for the version of SMART Product Drivers you're
removing, including the braces (“{" and “}").

Version Product code

10.0.124.0 {FF7AB64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.131.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.163.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.165.1 {FF7AB4AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.186.2 {FF7AB4AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.188.3 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.232.4 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.255.5 {FF7AB64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.314.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.392.6 {00C68967-9790-40DA-86F7-FDB248A5CDB1}
10.0.528.7 {AA9C1126-50DD-4993-9CDC-0BED8167293C}
10.0.532.7 {984EAE92-6043-451A-B786-9327FF 165310}
10.6.48.0 {2623A1E3-478A-4F4A-A522-3A3D784A0C9C}
10.6.106.1 {487F1117-8BDE-4518-A798-015172AE0410}
10.6.175.2 {333B0B76-FC96-4C51-9AF6-B6EFA15ACE99}
10.7.81.0 {1355416A-967D-47C5-823D-D493C3EOB97C}
10.7 SP1 {4CE6C6ES8-0DAD-4757-86ED-7FB4035BA98B}
10.8 {67E6410C-1E97-4D03-BEC2-8E83323A6BBD}
11.x {E3189F44-F7BD-4F96-B756-A0AEFAF61D3A}

o [Parameter] is the installation parameter (see Parameters on page 80).

To remove SMART Ink

CAUTION

o Removing SMART Ink can cause your interactive product’s pens to stop responding if
you aren’t running SMART Meeting Pro 3.0 software or newer.

o Removing SMART Ink software also removes all SMART Ink software patches.

If you installed SMART Ink using the SMART Product Drivers Installer.msi file, run the
following command to remove the software using the installation package:

msiexec /x " [Path]\SMART Product Drivers Installer.msi"

[Parameter]
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Where

o [Path] is the path to the SMART Product Drivers Installer.msi file.

o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove SMART Ink using the product code:

msiexec /x [Product code] [Parameter]

Where

o [Product code] is the product code for the version of SMART Ink you're removing,
including the braces (“{" and “}").

Version Product code
1.0 {4A1F2472-6164-43FA-9D2F-B35E71A8DF 32}
1.1 {4A1F2472-6164-43FA-9D2F-B35E71A8DF 32}

o [Parameter] is the installation parameter (see Parameters on page 80).

To remove SMART Common Files

CAUTION
Removing SMART Common Files can cause your SMART software to stop responding.

If you installed SMART Common Files using the SMART Product Drivers Installer.msi file,
run the following command to remove the software using the installation package:

msiexec /x " [Path]\SMART Product Drivers Installer.msi"

[Parameter]

Where

o [Path] is the path to the SMART Product Drivers Installer.msi file.

o [Parameter] is the installation parameter (see Parameters on page 80).
OR

Run the following command to remove SMART Common Files using the product code:

msiexec /x [Product code] [Parameter]
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Where

o [Product code] is the product code for the version of SMART Common Files you're
removing, including the braces (“{" and ‘}").

Version Product code
2011 (10.8) {OE5DD7A3-BE29-430C-970B-C553F4A58C39}
2012 (11.x) {ED2455F7-6AA6-4D3C-85E9-A72297DD7051}

o [Parameter] is the installation parameter (see Parameters on page 80).

To remove SMART Product Drivers and SMART Common Files

Run the following command:

msiexec /x " [Path]\SMART Product Drivers Installer.msi"

[Parameter]
Where
o [Path] is the path to the SMART Product Drivers Installer.msi file.

o [Parameter] is the installation parameter (see Parameters on page 80).

H NoTE

This procedure may vary depending on your version of Windows operating system and your system
preferences.

To remove a deployed installation package

1. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

The Active Directory Users and Computers window appears.
2. Right-click your domain, and then select Properties.

The Properties dialog box appears.
3. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.
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4. Browse to Computer Configuration\Software Settings\Software Installation.
5. Right-click the software you want to remove, and then select All Tasks > Remove.
6. Select Immediately uninstall the software from users and computers, and then click OK.

The next time each computer on the domain starts, the computer automatically removes the
software.
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SMART Meeting Pro installation package
The following are properties for the SMART Meeting Pro installation package:

Property Allowed values Notes

General properties

TRANSFORMS [String]: A language MST file forthe | Ensure the specified MST file is in
installation (see Installation language |the same folder as the MSI file.

files and codes on page 81). This property defines the language of
the installer’'s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software
uses the computer's operating
system language if it’s supported, or
English (U.S.)if not.

You can also use the
TRANSFORMS property to apply an
MST file created by

SMART Install Manager (see Using
SMART Install Manager on page 15)
or a third-party tool.
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software.

[Empty string]: Register the product
key but don’t automatically activate
the software.

Property Allowed values Notes
INSTALLDIR [String]: The path to your preferred If you don’t specify a folder,
folder for SMART Meeting Pro Windows Installer installs
software. SMART Meeting Pro software in

C:\Program Files\SMART
Technologies\SMART Meeting
Pro.

ENABLE_MP_ 0 (default): None Determines which communication

CONNECTOR_ 1: Bridgit layer SMART Meeting Pro software

LYNC 2:Lync uses.

ISX_ [String]: A 22- or 25-character This property automatically appears

SERIALNUM SMART Meeting Pro product key. in the Product Key box in the
activation wizard if you choose not to
include the ACTIVATE_LICENSE
property.

LYNC _ [String]: A 22- or 25-character Lync This property automatically appears

SERIALNUM product key. in the Product Key box in the
activation wizard if you choose not to
include the ACTIVATE_LICENSE
property.

ACTIVATE_ 1 (default): Register the product key | You must include the

LICENSE and automatically activate the ISX_SERIALNUM property for this

property to work.

For mass activation information, see
page 35.

SMART Meeting Pro software properties

BRIDGIT_
SERVER_NAME

[String]: The name of the Bridgit
server (for example,
bridgit.example.com).

The Bridgit server enables the
SMART Meeting Pro software
installation to connect to other
SMART Meeting Pro software
installations. For more information,
see smarttech.com/bridgit.

If no server name is provided, Bridgit
software integration is disabled.

SERVER_PWD

[String]: The access password for the
Bridgit server.

CREATION_PWD

[String]: The creation password for
the Bridgit server.
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0 (default): Don’t share the main
screen each time a user starts a new
session.

Property Allowed values Notes
ENABLEBRIDGIT |1: Share the main screen each time a
AUTOSHARE user starts a new session.

ENABLEBRIDGIT

SHOWPASSWORD

1 (default): Show the meeting
password in text on the Bridgit
Collaboration Bar.

0: Mask the meeting password on the
Bridgit collaboration bar.

ADMIN_PWD

[String]: A password that users must
enter to modify the

SMART Meeting Pro software
settings.

If you don’t specify a value, no
password will be required to change
SMART Meeting Pro software
settings.

EMAIL_ADDRESS

[String]: Type the sender e-mail
address for the SMART Meeting Pro
software installation.

Users can e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software. The
software uses this e-mail address in
the Sender field.

EMAIL_SERVER

[String]: An e-mail server for the
SMART Meeting Pro software
installation (for example,
mail.example.com).

Users can e-mail Whiteboard files to
themselves or to other users in
SMART Meeting Pro software. The
software uses this e-mail server to
send the file.

CALLIGRAPHIC_
INK

smoothes your writing strokes and
improves the readability of your notes.

0: Use regular ink.

USE_SYSTEM 0 (default): Don’t use the computer's | The default e-mail client must be
EMAIL default e-mail client to send e-mail properly configured for e-mail to be
messages. sent.
1: Use the computer’s default e-mail
client to send e-mail messages.
USE_ 1 (default): Use calligraphic ink, which

CREATE_
DESKTOPICONS

1 (default): Include a shortcut to the
software on the desktop.

[Empty string]: Don’t include a
shortcut to the software on the
desktop.

LOSU_
MEETINGPRO

1 (default): Start SMART Meeting Pro
software when the user logs on.

0: Don’t start SMART Meeting Pro
software when the user logs on.
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0: Don’t enable Microsoft Exchange
integration.

Property Allowed values Notes
ENABLE _ 1 (default): Enable Microsoft You must also add the room
EXCHANGE Exchange integration.

resource’s unique e-mail address
after installation (see Adding a
unique e-mail address to each
computer after installation on page
37).

EXCHANGE_RM_
EMAIL

[String]: A room resource e-mail
address to link with Microsoft
Exchange.

Each computer requires a unique
room resource e-mail address.

EX_AUTO_START

1 (default): Automatically start
scheduled meeting at logon.
0: User must manually start
scheduled meeting after logon.

EX_AUTO _BOOK

1 (default): Automatically book an
unscheduled meeting at logon.
0: User must manually book an
unscheduled meeting after logon.

If you select 1, an unscheduled
meeting starts automatically at logon
if the room resource is available for
the next 30 minutes.

EX_AUTO_RESET

1 (default): Automatically reset room
after meeting end time.

0: Disable automatic room reset.

EX_RESET _DELAY

5 (default): Delay time in minutes
before automatic room reset feature
activates.

Type the preferred delay time in
minutes. Only delay values of 1, 5 or
10 minutes are supported.

MEETING_MODE

software starts in Whiteboard mode.

1: SMART Meeting Pro software
starts in Desktop mode.

EX_AUTO_ 1 (default): Automatically insert The agenda includes any meeting
AGENDA agenda after meeting starts. details the user typed in the meeting
0: Disable automatic insertion of invitation in Outlook.
agenda.
GALLERYDIR [CommonAppDataFolder\SMART The path to the Added Content
Technologies\Gallery\My Content folder, which is on the local computer
where user-created content is
stored.
EXTOLLER [String]: Specify the path to add This property is optional.
additional Gallery content folders.
DEFAULT_ 4 (default): SMART Meeting Pro

DEFAULT FILE_
FORMAT

0 (default): SMART Notebook
(*.notebook)

1: Adobe® PDF (*.pdf)
2: Microsoft PowerPoint® (*.ppt,
*.pptx)

Whiteboard files will be saved in this
format.
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SMART Product Drivers installation package

The following are properties for the SMART Product Drivers installation package:

IMPORTANT

o Before deploying the SMART software installation packages, you must deploy the following
third-party packages: Microsoft .NET Framework 4 Full files and Microsoft Visual Studio
Tools for Office.

e The SMART Product Drivers installation package includes SMART Ink and SMART
Common Files. You must deploy the SMART Product Drivers installation package before
you deploy the SMART Meeting Pro software installation package.

o If you want to install language packs, you must do so when you first deploy the software. If
you want to install a language pack after you first deploy the software, you must do so using
the language pack’s individual MSl file.

Property

Allowed values

Notes

General properties

TRANSFORMS

[String]: A language MST file for the
installation (see Installation language
files and codes on page 81).

Ensure the specified MST file is in the
same folder as the MSI file.

This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software uses
the computer's operating system
language if it's supported, or English
(U.S.)if not.

You can also use the TRANSFORMS
property to apply an MST file created
by SMART Install Manager (see Using
SMART Install Manager on page 15)
or a third-party tool.

INSTALLDIR

[String]: The path to your preferred
folder for SMART Product Drivers.

If you don’t specify a folder, Windows
Installer installs

SMART Product Drivers in
C:\Program Files\SMART
Technologies\SMART Product
Drivers.
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0: Don’t notify the user when updates
are available from SPU.

Property |AIIowed values Notes
SPU properties
INSTALL_SPU 1 (default): Install SPU in Full mode. In Full mode, users can view the
2: Install SPU in Dashboard mode. installed versions of SMART software
0: Don't install SPU. as well as their product keys, and
download and install updates.
In Dashboard mode, users can view
only the installed versions of SMART
software and their product keys.
SPU_TIME_ [Integer]: The time in days (1 to 60) By default, SPU checks for product
FRAME between SPU checks. updates every 30 days.
This property is applicable only if you
install SPU.
PRODUCT _ 1 (default): Notify the user when This property is applicable only if you
NOTIFICATION |updates are available from SPU. install SPU.

SMART Product Drivers properties

user logs on.

[Empty string]: Don’t start SMART Ink
when the user logs on.

INSTALL _ 1 (default): Enable the registration of | Disable the registration of
DOCCAM_ SMART Document Camera drivers. SMART Document Camera drivers if
DRIVERS 0: Disable the registration of they conflict with existing third-party
SMART Document Camera drivers. | drivers on the computer.
LOSU_ 1 (default): Start
BRDTOOLS SMART Product Drivers after the
installation.
[Empty string]: Don’t start
SMART Product Drivers after the
installation.
ENABLE_ 1 (default): Use Tablet PC This property is applicable to Windows
STPCS functionality with the SMART Board 7 operating system only. It has no
interactive whiteboard without effect on other operating systems.
connecting a Tablet PC. If you specify [Null], users don’t have
[Empty string]: Don’t use Tablet PC touch support at the Windows logon
functionality with the SMART Board screen.
interactive whiteboard without
connecting a Tablet PC.
LOSU_INK 1 (default): Start SMART Ink when the

78




APPENDIX A

Windows Installer properties and parameters

Property

Allowed values

Notes

DEFAULT_PDF

1 (default): Set SMART Ink Viewer as
the default PDF viewer.

[Empty string]: Don’'t set SMART Ink
Viewer as the default PDF viewer.

0 (default): Disable the registration of
unsigned third-party drivers.

CUSTOMER _ 0 (default): Disable the Customer
LOGGING Experience Program.

1: Allow the user to enable or disable

the Customer Experience Program.
INSTALL 1: Enable the registration of unsigned | If you enable the registration of
UNSIGNED_ third-party drivers. unsigned third-party drivers, the
DRIVERS installation process could ask users if

they trust the makers of the drivers
during installation. This can cause
issues if you deploy the installation in
Silent mode. Therefore, it’s best to
disable the registration of third-party
drivers if you deploy the installation in
Silent mode.

Language pack properties
Don’t select more than 20 language packs (see smarttech.com/kb/170081).

ZH_CN 1: Install the Chinese (Simplified)
language pack.

CS 1: Install the Czech language pack.

DA 1: Install the Danish language pack.

NL 1: Install the Dutch language pack.

EN_GB 1: Install the English (UK) language
pack.

FR 1: Install the French language pack.

DE 1: Install the German language pack.

IT 1: Install the Italian language pack.

JA 1: Install the Japanese language pack.

NB 1: Install the Norwegian language
pack.

PT PT 1: Install the Portuguese (Portugal)
language pack.

PT BR 1: Install the Portuguese (Brazil)
language pack.

RU 1: Install the Russian language pack.

ES 1: Install the Spanish (Spain) language

pack.
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Property Allowed values Notes
ES_MX 1: Install the Spanish (Mexico)
language pack.
SV 1: Install the Swedish language pack.
TR 1: Install the Turkish language pack.

The following are the standard Windows Installer parameters for the msiexec command.

Parameter Use
/q Hide the installation wizard.
H NOTE
This is Silent mode.
/gb Show a basic installation wizard.
/gb! Show a basic installation wizard without a Cancel button.
/qb+ Show a basic installation wizard with a dialog box signaling the end of the
installation.
/gb+! Show a basic installation wizard without a Cancel button but with a dialog box
signaling the end of the installation.
lqr Show a reduced installation wizard.
Iqf Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
/gn Hide the installation wizard and the dialog box signaling the end of the
installation.
/gn+ Hide the installation wizard but show the dialog box signaling the end of the
installation.
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Installation language files and codes

Language packs

Installation language files and codes

Language Code File

English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Chinese (Simplified) 2052 2052.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
Dutch 1043 1043.mst
French (France) 1036 1036.mst
German 1031 1031.mst
Italian 1040 1040.mst
Japanese 1041 1041.mst
Norwegian 1044 1044.mst
Portuguese (Portugal) 2070 2070.mst
Portuguese (Brazil) 1046 1046.mst
Russian 1049 1049.mst
Spanish (Spain) 1034 1034.mst
Spanish (Mexico) 2058 2058.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst
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File

Code

chinese_(simplified)_language_
pack.msi

{0507C320-0AAC-48C5-A9E2-5EF1939EDF56}

czech_language_pack.msi

{D4D68022-BE82-4C7B-87D5-2460A9BDB001}

danish_language_pack.msi

{1EAB215B-E60D-4734-81C6-20D2A7A3B5A3}

dutch_language_pack.msi

{9B2B8676-0C52-4F97-9869-3EOCC87C85EQ}

english_(united_kingdom)_language_
pack.msi

{AD53E305-0F31-426E-85D 1-35C63D 913639}

french_language_pack.msi

{015BE11B-72BE-44C4-99BA-36CA831757E4}

german_language_pack.msi

{6C3C89CB-A719-46C5-80C7-2E2237AD 3692}

italian_language_pack.msi

{DBOD6AF8-FC14-43B2-B3CE-5A6C8C89CF44}

japanese_language_pack.msi

{649C11F3-9B7D-423C-BBOF-AD5F985DEO3A}

norwegian_language_pack.msi

{E5B6189B-2FEE-4BOF-98DE-F86F04975528}

portuguese_(portugal)_language_
pack.msi

{F9914964-383B-4B92-ADEC-6A5608566219}

portuguese_(brazil)_language_pack.msi

{97A542D0-3E82-4F 73-A594-7E284559C66F}

russian_language_pack.msi

{6BDED2D7-9987-49B1-81B8-6EB2B38B559A}

spanish_language_pack.msi

{29ADE094-DA64-46EC-835C-1DEC4A035614}

spanish_(international_latin_american)_
language_pack.msi

{F7CO6E3B-9BC3-411C-867E-53CAE223DB13}

swedish_language_pack.msi

{640A01FF-E76A-458B-A630-EE8BCDBF4649}

turkish_language_pack.msi

{C1F6AEE2-93BE-408B-8941-856A8B6IE1B7}
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polling intervals

A user can start a scheduled meeting or an unscheduled ad hoc meeting when he or she logs into a
room resource computer. Depending on the availability of the room resource, meetings can be started
automatically or manually. To enable this, SMART Meeting Pro software polls the Microsoft
Exchange Server that it’s integrated with to retrieve the logged in user's calendar and the times that a
room is booked.

SMART Meeting Pro software polls the Microsoft Exchange server at the following intervals:

e When SMART Meeting Pro software starts.

o Every 10 seconds for the first five minutes after the start of a meeting (to enable meeting rooms
to automatically join a Bridgit meeting).

o Once every minute after the first five minutes of a meeting (to ensure that a user can extend a
meeting only if the room is available beyond the scheduled meeting).

o When a different user logs into the room resource computer with his or her network credentials.

a Tip

See the SMART Meeting Pro software online Help for more details on extending a meeting and
adding other meeting rooms to a scheduled meeting.

H NoTE

SMART Meeting Pro software polls the Microsoft Exchange Server only for the time stamp that
records the last time a user or room calendar was changed. If the time stamp received from the
server is later than the time stamp saved by SMART Meeting Pro software, then

SMART Meeting Pro software will access the room or user calendar (or both). By using this polling
rate, SMART Meeting Pro software significantly reduces the load on the Microsoft Exchange
Server.
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